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SET-UP GUIDE

Important information on how to:
• Install, activate and use SimpleStart 
• Find answers to your questions
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Welcome to QuickBooks SimpleStart, the simplest way to manage your sales, 
expenses and customers with ease. Follow these easy steps to install your 
new software and get started.

1.	Shut down all programs that are open, including any virus protection software.

2.	 Insert the SimpleStart Installation CD in your CD-ROM drive. If the software does not start 
automatically, do the following:

Installing SimpleStart

Click the             (Start) 
button on the Windows 
taskbar and select Run.

Type the letter that is associated 
with your CD-ROM drive (in this 
example, it is D), then type  
:\launch.exe. Click OK.

3.	When prompted to, enter your license number and product number.
Where can I find my license and product numbers?  Each copy of SimpleStart has two 
identification numbers which are needed to install the software. These are the License 
number and the Product number. Their location depend on how you purchased your 
software. Use the table below to help you locate your installation numbers. We highly 
recommend that you store your numbers in a safe place in case you need to reinstall the 
software. You can record your numbers on page 5.

If you purchased SimpleStart... then the numbers are provided...

in a retail store on the back of the CD sleeve

by calling Intuit directly on the reverse side of the Intuit invoice that accompanied 
your software

as a downloadable version 
through our website

on the reverse side of the Intuit invoice

It’s never been so easy to start your business right.  
Right from the start.
Thank you for choosing Intuit UK to help you manage your business. We’re excited to 
provide you with QuickBooks SimpleStart, a breakthrough in simple bookkeeping for new 
and home-based business. Designed for first-time software users, SimpleStart makes it 
simple to get started with extremely easy, practical tools to manage essential business 
tasks. No confusing set up. No unnecessary features. Just common sense tools that are 
easy to set up and easy to use.

With SimpleStart you’ll be able to:
•	 Invoice customers and pay bills.
•	 Track expenses.
•	Do your cash based VAT Returns.
•	Run your Profit and Loss report easily.

This Set Up Guide contains important information on how to install, activate and  
use SimpleStart.

We’re here to help you get the best products and services to keep you on track and be as 
productive as possible. And most importantly, to help you spend more time making money 
than managing it! Plus, you’ll never outgrow QuickBooks. Even if your business grows and 
your needs change, it’s easy to upgrade to other QuickBooks products. 

QuickBooks SimpleStart. It’s that easy.
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If you want to install  
to the default 
directory, just click 
the Next button at 
the bottom of  
the screen.

To install to a 
different directory 
than the default, 
click the Change  
new directory  
button, then specify 
your new directory.

4.	At the Install Options screen, choose where you want SimpleStart to be installed.

5.	 Follow the instructions until the software is installed, then restart your computer.

If the software detects that Internet Explorer (IE) version 6.0 is 
not installed on your computer, this checkbox is selected. Do 
not clear this checkbox if it is selected. IE 6.0 is needed for 
SimpleStart to run properly.

Registering SimpleStart

Once SimpleStart is installed on your computer, you must activate the 
software. Registration is a fast and easy process that validates you as the 
licensed user of SimpleStart. 

Note  If you use the Internet, make sure you are connected to it before you begin activation. 
Intuit respects your privacy. To view our privacy policy, visit quickbooks.co.uk and click the 
“privacy” link.

1.	Open QuickBooks SimpleStart. 
Click the QuickBooks SimpleStart 
icon on your desktop, or from the 
Start menu, go to Programs and 
select QuickBooks.

2.	 The Setup Interview opens 
automatically. Follow the onscreen 
instructions of the Setup Interview 
to create your company file. This 
takes only a few minutes.

3.	Once your company file is  
created and SimpleStart is  
open, go to the File menu and 
select Register QuickBooks.

If you choose to register your 
software at a later time, you will 
be asked to register each time 
you open your company file until 
the 10th use. After the 10th use, 
you cannot modify any data in 
your company file until you have 
registered.

4.	Click Begin Registration. 
SimpleStart will automatically try 
to register QuickBooks over the 
internet. If SimpleStart cannot 
connect to the internet, you will 
be able to register by phone. 

•	 Registering through the Internet  If you 
register through the Internet, the software 
sends your product information to Intuit and 
automatically registers your software for you. 
This is a safe and secure process.

•	 Registering by phone  If you register 
QuickBooks SimpleStart by calling us, the 
QuickBooks representative will ask you for 
your License number and Product number. 
You can find this number on the same screen 
that prompted you to call us. The QuickBooks 
representative will give you a code which you 
must then enter in the Validation Code field, 
also located on the same screen. 

When you have registered your software, you  
can see the details of your license information  
by going to the Help menu and selecting  
My License Information. 

Write your QuickBooks SimpleStart codes here for 
your reference:

License number

Product number

Validation Code (if applicable)
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Getting around

Getting Started
To open simpleStart  
Click the QuickBooks 
SimpleStart icon on your 
desktop, or from the Start 
menu, go to Programs 

and select QuickBooks. If you have no 
company file created, the Setup Interview 
starts automatically and takes only a 
few minutes to complete. (If you haven’t 
activated, see Activating SimpleStart  
on page 5.)

To set up a bank account  
You’ll use it to track the 
cheques you write and 
deposits you make. On 

the Home page in the Your Business 
area, move your mouse pointer over 
Bank Accounts and click Register. Use 
your latest bank statement to enter the 
opening balance and date so your records 
will be accurate.

To use the tutorials  They’re short, 
interactive, and you’ll learn how easy it is 
to track your business activities. From the 
Get Started Now area on the Home page, 
click Check Out the Tutorials.

Tracking the money coming in 
to your business

Start billing your 
customers  On the Home 
page in the Money In area, 
move your mouse pointer 

over Invoices or Sales Receipts and click 
New to fill out the appropriate sales form.

Understanding SimpleStart terms
•	 Customers are the people to whom you sell your products or services, that is, the 

people who pay you for what you do. Some businesses might refer to a customer as a 
client or a member.

•	 Suppliers are any businesses or people from whom you buy things for your business 
– office supplies, phone or computer services, suppliers of the products that you sell. 
In SimpleStart, the VAT office is considered a supplier.

•	 Items are the products and/or services that you sell. You enter items on your invoices 
and sales receipts.

•	 Transactions are anything you record for Money In or Money Out of your business. 
Whenever you create an invoice, write a cheque, or make a deposit, you are recording 
a transaction in your company file.

•	 Accounts are used to track transactions related to your business income (e.g., sales) 
and expenses (e.g., travel).

Record an invoice payment 
from a customer  On the 
Home page in the Money 
In area, move your mouse 

pointer over Receive Payments and click 
New. Be sure to indicate whether the money 
is going directly in to your bank account 
or whether you are grouping it with other 
payments to deposit at a later time.

Make a bank deposit  
On the Home page in 
the Money In area, move 
your mouse pointer 

over Deposits and click New. Select the 
payments that you will be taking to the bank 
for deposit.

Tracking the money going out 
of your business

Write a cheque to pay  
a bill  On the Home page 
in the Money Out area, 
move your mouse pointer 

over Write Cheques and click New. Fill out 
the cheque just as you would fill out one in 
your cheque book. You can print the actual 
cheque or just track a handwritten one. If 
you are tracking VAT, make sure you enter 
an expense category and select the correct 
VAT code.

Record a cash or credit 
card expense  On the Home 
page in the Money Out area, 
move your mouse pointer 

over Record Expenses. Click Cash or Credit 
Card to enter the appropriate expense.
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Menu Bar  If you don’t see what you want to do on the 
Home page or in the activities listed on the left side of the 
SimpleStart window, you can find it on one of these menus.

Home Page  Your starting point for doing all your essential business activities — invoicing, creating 
sales receipts, recording customer payments, writing cheques for business expenses, and more. 
Move your mouse over an icon, then click the activity.

Toolbar  Click Back and Forward to move between forms. 
Click Home to return to this Home page view. Click Search 
to look for a specific invoice, sales receipt, or customer 
payment.

Money In  Basic activities related to money coming in to 
your business. These activities are the same ones that you 
see in Money In on the Home page. 

Your Business  Enter or view information about your 
customers, suppliers, and bank accounts. Click Profit &  
Loss to see the financial state of your business. 

Money Out  Basic activities related to money going out of 
your business. These activities are the same ones that you 
see in Money Out on the Home page. 

Related Activities  These activities are relevant to your 
current activity. When you change to a different activity, the 
activities here change accordingly. These activities do not 
appear on the Home page or on the menus.

Related Help  Relevant help topics for your current activity. 
When you change to a different activity, the topics here 
change accordingly. If you don’t see the topic you need,  
type a question into the search box and click Ask. You can 
also use the Help index located on the Help menu.

Need your questions answered?  Type your question in this 
box, then click Ask. Our search engine will search the online 
help and list all topics that are related to your question.

Get Started Now  Click these links to help familiarise 
yourself with your software. Use the interactive tutorials to 
learn how to use SimpleStart. Then find out what to do  
next, and how to get help when you need it. 

Growing Your Business  Click these links for the 
Google Marketing Tools services, for business startup 
advice, or to upgrade to a different QuickBooks 
products when your business outgrows SimpleStart.

SimpleStart Home Page
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Getting help Contacting us

Using the online help
•	 Try the Related Help/Help Activities 

or the Help menu  On the Home 
page in the lower left-hand side of the 
window, you’ll see a list of help topics 
that are related to the activity you are 
doing. For example, if you are filling out 
an invoice form, help topics related to 
the creation of invoices are displayed 
(e.g., filling out an invoice and creating 
items). You can also access our 
extensive help topics through the Help 
menu located on the Menu Bar.

•	 Type your question — find an answer  
You can search the QuickBooks help 
by typing your question into the search 
box on the Home page then clicking 
Ask. You can also open the search 
engine through the Help menu.

•	 Help Index  View an index of all the 
help topics available to you. Go to the 
Help menu, and select Help Index. 

•	 Get up and running quickly using  
the Tutorials  These interactive 
tutorials teach you the basics and take 
only a few minutes to complete. You 
can get to them from the Home page 
under Get Started Now.

•	 QuickBooks Support Plan   
Support Plans can be purchased 
by calling us on 0845 606 2161. 
Customers with a valid plan are able 
to access information to enhance their 
business and interact with each other 24 
hours a day, 7 days a week. 
>	 Unlimited Telephone Support  

Available during office hours, 9:00am 
to 5:30pm Monday to Friday (except 
UK Bank Holidays). 

>	 Live Chat  With real time live chat, 
members can talk with each other 
about their business or any other 
subject.

>	 Bulletin Boards  Members can  
post messages to each other on 
various topics. 

If you would like to purchase a  
SimpleStart Support Plan or speak with  
one of our Support experts, please call 
0845 606 2161.

•	 Quickbooks ProAdvisors   
QuickBooks ProAdvisors are a network 
of accountants across the UK who are 
experienced on the use of QuickBooks 
products. Visit advisors.quickbooks.co.uk 
to find an advisor in your area.

Using SimpleStart  
online support
•	 Quickbooks Knowledgebase  This online 

knowledgebase has hundreds of articles 
and Frequently Asked Questions. Visit 
faq.quickbooks.co.uk

•	 Other QuickBooks Web sites  Below 
is a list of related Web sites where you 
can find up-to-date information about 
SimpleStart.
>	 quickbooks.co.uk  general 

information on QuickBooks products 
and services

>	 intuitshop.co.uk  to purchase Intuit 
products and services

>	 quickbooksstationery.co.uk  
information on QuickBooks business 
forms, cheques and stationery 
compatible with your software

•	 Other key QuickBooks related  
contact numbers
>	 0845 606 2161  to purchase or 

inquire about QuickBooks products 
and services, to inquire about 
activation, or ask questions about your 
QuickBooks account

>	 0800 279 5285  to purchase 
or inquire about Intuit stationery 
(cheques, business forms, and  
other stationery)

•	 Address for product returns
All product returns made under the 30 
day money back guarantee must be sent 
via registered mail to: 

Intuit Limited Service Centre
P.O. Box 4944
Twyford, Reading  RG10 9BF
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Is it time to upgrade from SimpleStart?

Running a successful business can be challenging. Knowing what tools you’ll 
need tomorrow is hard enough, let alone for months or even years down the road.

QuickBooks products are designed to work together seamlessly. That 
makes it easy to change your accounting software as quickly as your 
business changes!

QuickBooks Pro
QuickBooks Pro includes the 
easy-to-use tools to help you 
manage routine accounting 
tasks, from tracking stock to 
job costing and more. Grow 
your business and stay on track 
— with QuickBooks Pro.

QuickBooks Premier
Includes all of the features of 
QuickBooks Pro, plus advanced 
features to suit your complex 
business needs. QuickBooks 
Premier goes beyond the basics, 
including creating budgets and 
sales & expense forecasting.

Do you have employees?
Pay your employees quickly with 
QuickBooks Payroll. Just add 
QuickBooks Payroll to QuickBooks 
Pro or Premier for easy, accurate 
payroll.
•	Automatic tax table updates
•	Print payslips for your employees

Call 0845 606 2161 to learn more 
about QuickBooks Payroll.

Which one is right for you?
SIMPLESTART 

2008
PRO 
2008

PREMIER 
2008

SAVE TIME ON EVERY-DAY TASKS

Interview gets you up & running quickly P P P
Create invoices, print cheques and manage bills P P P
Monitor accounts payable P P
MANAGE PRODUCTS & SERVICES

NEW Store multiple delivery addresses  
per customer P P P

E-mail invoices & estimates as PDFs P P P
Track stock, set re-order points & create 
purchase orders P P

Automatically bill for & track employee  
time/job costs P P

Create sales orders & track back-orders P
IMPROVED Buy & sell stock in different units P
Set prices and determine discounts by 
customer/job P

Build and track inventory assemblies to  
finished goods P

FLEXIBILITY TO WORK THE WAY YOU WANT

Customise report templates & graphs 14 basic reports 100+ reports 135+ reports

Audit Trail to detect errors and track changes P IMPROVED IMPROVED

Customise professional-looking templates P IMPROVED IMPROVED

Set password-protected closing dates P P
IMPROVED VAT management Cash basis P P
Multiple-user access  
(with purchase of additional copies)2 Up to 52 Up to 52

Create budgets, business plans & forecasts P
Set flexible billing rates P
Access files from remote locations  
(additional fees may apply)3 1 year free

QBUK08 SS SetUpGuide.indd   12-13 7/28/07   12:40:06 PM



Local QuickBooks helpStationery

Invoices 
Professional Invoices

Perfect for solicitors, consultants and 
professions that bill by the project, but also 
require space to list their specific services.

Service Invoices

Ideal for accountants, designers, plumbers, 
caterers and anyone who bills their  
services hourly. 

Using the services of a professional 
advisor can help new and growing 
businesses to close the knowledge 
gaps that make them vulnerable. 
And the impartial, expert advice 
they offer could bring the wider 
perspective you need when it 
becomes difficult to see the wood 
for the trees.

As part of our support for the 
business community, we’ve created 
an on-line database of qualified 
accountants and IT consultants 
from all areas of the UK. 

You have free access to the simple, 
map-based tool which helps you 
search quickly by region, by location 
or even by name.

When money is on the line, it’s important that your company always presents 
a professional image. 

Now you can personalise your invoices and cheques — with the guarantee that 
everything will fit your software - and that’s a money-back guarantee! As well 
as saving time managing both your business, you’ll also benefit from seamless 
integration with your QuickBooks software.

Cheques
The only cheques you can re-order from 
within QuickBooks. The perfect choice for 
professionals — both at work and at home.

Voucher Cheques

The clear, concise layout helps to improve 
efficiency, payment accuracy and cash  
flow — as well as making reconciliation 
easier too.

Standard Cheques

Helps to ensure prompt payment, reduce 
queries and improve your cash flow. Full 
bank approval is obtained on your behalf. 

Call us on 0800 279 5285 to purchase or inquire 
about Intuit stationery 

See how easy it is
quickbooks.co.uk/findanadvisor

Finding the business…doing the business… running the business. Often it’s 
the last part that causes most problems and which may eventually lead to an 
unhappy failure. 
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SimpleStart help

quickbooks.co.uk

© 2007 Intuit Inc. QuickBooks is a registered trademark of Intuit Inc. Other products are trademarks  
of their respective manufacturers.

IU2081008/1

30-days FREE support

We’re here to help! New or upgrading customers receive free telephone 
assistance for 30 days from your product registration date. To take full 
advantage of this help, you must register your software within 90 days  
of purchase.

Call 0845 606 2161 or +44 870 609 0601 
from outside the UK for support. Phone lines 
are open from 9am to 5.30pm, Monday to 
Friday (except UK Bank Holidays).

Questions?
Call us on 0845 606 2161  
for answers about QuickBooks products and 
services, registration or your QuickBooks 
account.

Product returns
All product returns made under the 30-day 
money-back guarantee must be sent via 
registered mail to:

Intuit Limited
PO. Box 2234
Maidenhead, Berkshire SL6 1YW
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